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1. Scope 
 
This document is intended to detail a typical installation and configuration of the Dialogic® 4000 Media Gateway 
Series if used to interface between a PBX and the Microsoft® Office Communications Server (OCS) 2007 
application. 
 
2. Configuration Details 
 
Listed below are details of the PBX and gateways used in the testing on which this document is based.  
 
2.1 PBX 
 

PBX Vendor Avaya 

Model(s) S8500 

Software Version(s) Comm manager 3.0 – R013x.00.1.346.0 

Additional Notes N/A 

 
2.2 Gateway 
 

Gateway Model Dialogic® 4000 Media Gateway Series  

Software Version(s) Dialogic® Diva® System Release software version 8.3.2 build 459 
(formerly called Diva® Server software) 

Dialogic® Diva® SIPcontrol™ Software version 1.6 build 46 
(DSSIPControl.msi) 

Protocol T1 Q.SIG 

 
 
2.3 System Diagram 
 
The diagram below details the setup used in the testing and creation of this document. In the diagram, the 
abbreviation DMG4000 stands for the Dialogic® 4000 Media Gateway Series and OCS Server stands for 
Microsoft® Office Communications Server (OCS) 2007. 
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PBX DMG4000

T1/E1

IP LAN

OCS Server

OCS Clients
5100         5101

TDM Stations
2410         2401

 
 
 
3. Prerequisites 
 
3.1 PBX Prerequisites 
 
The PBX must have all supplemental service packages installed for the Q.SIG protocol to operate properly and 
to provide all advanced supplemental services. 
 
3.1.1 PBX Equipment Required 
 
To support the T1 Q.SIG configuration as documented, the TN464F DS1 interface card is needed. 
  
3.1.2 PBX Cabling Requirements 
 
The cabling for Q.SIG connections must be CAT5e or better. A standard voice quality cable will not provide the 
desired signal quality and will cause the gateway to have issues establishing a connection on the D-channel. 
 
3.2 Gateway Prerequisites 
 
The gateway needs to support a T1 Q.SIG interface. 
 
4. Summary of Limitations 
 
No limitations noted as of the most recent update to this document. 
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5. Gateway Setup Notes 
 
Steps for setting up the gateway: 
 

1. Configuration of the Dialogic® Diva® Media Board drivers. 
2. Configuration of the Dialogic® Diva® SIPcontrol™ software. 

 
5.1 Dialogic® Diva® Media Board Configuration 
 
The Diva Media Boards are configured in the Dialogic® Diva® Configuration Manager. To open the Configuration 
Manager, click:  
 
Start > Programs > Dialogic Diva > Configuration Manager. 
 
Note: In the Dialogic® Diva® software and documentation, Diva Media Boards are referred to as Diva Server 
adapters. 
 
A screen similar to the one below will appear. 
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Note: The number of TDM circuits varies depending on the used Dialogic® Media Gateway model. 
 
For this setup:  

• Set the property Switch Type to Q-SIG T1. 
• If your PBX does not provide ring tones to callers from TDM, set the property Generate Ring 

Tones to Yes.  
 
To activate the change, click File > Activate. 
 
Make these configuration changes for each TDM circuit you are going to use on the Dialogic® Media Gateway. 
 
5.2 Dialogic® Diva® SIPcontrol™ Software Gateway Application 
 
The Diva SIPcontrol software is configured via the web based interface. To open the web interface, click Start 
> Dialogic Diva > SIPcontrol Configuration.  
 
On the main page, click the SIPControl link to display the different configuration menus.  
The PSTN Interface Configuration section should automatically include all ports detected in the system. 
 
Note: If you do not see any detected ports, you may need to add http://127.0.0.1 as a trusted site. From 
Microsoft® Internet Explorer, click Tools > Internet Options > Security > Trusted Sites. Use 
http://127.0.0.1:10005 to get to the configuration. 
 
In order for the Diva SIPcontrol software to route calls, the proper routes must be created and configured. Each 
route consists of a source interface and a destination interface. PSTN controllers and SIP peers are considered 
either a source interface or a destination interface depending on the call direction. 
 
 
5.2.1 PSTN Interface and Network Interface Configuration 
 
The following is a typical configuration.  
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The Network Interface Configuration will be used by the Diva SIPcontrol software for listening to the 
SIP traffic from Microsoft® Mediation Server. Given that on these gateways the Microsoft® Mediation Server 
component and the Diva SIPcontrol software are running in the same system, you will need to change SIP 
Listen port to 9803 or to an available un-used port. Later during the Microsoft® Mediation Server 
configuration, you will need to set the PSTN Gateway next hop setting to 9803 to match.  
 
5.2.2 SIP Peer Configuration 
 
Create one SIP peer to talk to Microsoft® Mediation Server as shown below. 
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5.2.3 Routing Configuration 
 
In the Routing Configuration section, you must create two routes, one for the inbound direction (TDM to 
IP) and one for the outbound direction (IP to TDM). Once you have created the routes, click the Save button for 
the changes to take effect. 
 

 
 
5.2.4 Number Normalization 
 
The Dialplan Configuration and Address Map Configuration sections are used for manipulating dial 
numbers. For most PBX dialplans, an address map is required. See the following examples. 
 
 
 
 



Dialogic® 4000 Media Gateway Series Integration Note  

9 

5.2.4.1 Dialplan Configuration Example 
 
To create a dialplan, click Add from the Dialplan Configuration. The following screens show how to set up 
a dialplan for a Microsoft® Office Communications Server (OCS) 2007 application with the following dialplan from 
the PBX. (This may not match to the PBX programming in section 6 and the Setup in section 2.3). 
 
Area code: 716 
Base number: 639 
Extensions: 4 digits 
Access code: 9 
 

 
 
Complete the settings and click OK. 
For the dialplan to be applied to outbound calls, click the Details button of the PSTN controller and configure 
the Address Normalization settings as shown in the screen below. This converts the dialed numbers into 
the format based on the dialplan for the PBX. If the dialed number is for an internal user, it is converted into a 4-
digit extension. If the called number is for a national call, 91 is prepended. Click OK on this page, and Save on 
the next page for the changes to take effect. 
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For the dialplan to be applied to inbound calls, click the Details button of the configured SIP peer and 
configure the Address Normalization settings as in the screen below. This converts the phone number into 
the E.164 format as needed by Microsoft® Office Communications Server 2007. Click OK on this page, and Save 
on the next page for the changes to take effect. 
 

 
 
 
5.2.4.2 Address Map Configuration Example 
 
If the dialplan does not meet your setups special requirements, the Address Map Configuration can be 
used. An address map entry uses regular expressions (RegEx) (so does Microsoft® Office Communications 
Server 2007) for converting the call address format for inbound or/and outbound direction. 
 
Important note before applying regular expression rules in address maps: The call address for outbound calls (IP 
to TDM) includes a “@hostname” part. For example, +17166391234@DMG4000.bufocs.local is the call address, 
not just +17166391234. For inbound calls (TDM to IP), the call address is the called or calling number, with a 
possible prefix “+”, “N”, or “S”. For example, an inbound call has called number 1234 with ISDN type of 
numbering flag set to Subscriber, and the calling number 49715233334444 with ISDN type of numbering flag 
set to International. The called address will be S1234 and the calling address will be +49715233334444.  
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If the ISDN type of numbering flag is set to National, the prefix “N” will be used with the call number. If the type 
is Unknown, no prefix is used. 
 
Outbound call example using address maps:  
 
Microsoft® Office Communications Server 2007 sends the E.164 dial number format to the SIP gateway. Both 
called and calling numbers need to be converted into a format that the PBX can accept. If the same PBX 
dialplan as in the previous section is used, the following conversions are needed. 
 
Calling number From Microsoft® OCS To PBX 
Internal  +1716639xxxx 716639xxxx 
 
Called number From Microsoft® OCS To PBX 
To Internal  +1716639xxxx xxxx 
To National  +1xxxxxxxxxx 91xxxxxxxxxx 
To International  +xxx…xxx +xxx…xxx 
 
Below is RegEx for the conversion tables above. 
 
Sub rule name Expression Format Stop on match 
Calling number ^\+1(716639\d{4}) $1 Not checked 
Called - Internal ^\+1716639(\d{4}) $1 Checked 
Called - National ^\+1 91 Checked 
Called - International ^\+ 9011 Checked 
 
Below are the configured address maps for outbound calls. The order of the below four sub rules and the stop 
on match check mark are relevant:   
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The following screen shows the first sub rule that converts the E.164 calling number into a  
10-digit national number: 
 

 
 
The following screen shows the second sub rule that converts E.164 for the internal called number into a 4-digit 
extension: 
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The following sub rule converts the E.164 national number into a 10-digit national number with prefix 91: 
 

 
 
The following example converts international call numbers: 
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Once an address map rule is created, it can be applied in three different places. To ease the configuration and 
troubleshooting processes, apply the rule on the outbound route as shown below: 
 

 
 
 
Inbound call example using address map: 
 
This example assumes that the PBX sends inbound calls using a 4-digit extension, with the ISDN type of number 
flag set to Subscriber for internal numbers, National for national calls, and International for 
international calls. 
 
Called number From PBX To Microsoft® OCS 
Internal xxxx (with subscriber type of number) +1716639xxxx 
 
Calling number From PBX To Microsoft® OCS 
Calling from internal xxxx (with subscriber type of number) +1716639xxxx 
Calling from national xxxxxxxxxx (with national type of number) +1xxxxxxxxxx 
Calling from international xxx…xxx (with international type of number) +xxx…xxx 
 
Sub rule name Expression  Format Stop on match 
Called ^S(\d{4})$ +1716639$1 Not checked 
Calling - internal ^S(\d{4})$ +1716639$1 Checked 
Calling - national  ^N(\d{10})$ +1$1 Checked 
Calling - international ^\+ + Checked 
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Create an address map named Inbound and its four sub rules as shown below: 
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Apply the address map inbound rule on the inbound route as follows: 
 

 
 
 
5.2.5 Restarting the Dialogic® Diva® SIPcontrol™ Software 
 
Note: A restart of the Diva SIPcontrol software service is needed only if the setting under Network Interface 
is changed.  
 
Save the configuration and restart the Diva SIPcontrol software service for the changes to take effect. To do so, 
click Service Status on the left hand side of the main configuration page, and then click Restart 
SIPcontrol. The Last operation log will show that the service has been stopped and started again. 
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6. PBX Setup Notes 
 
The basic steps of setting up the PBX for use with this gateway and a voice messaging system are as follows: 
 

1. Setting up system parameters and customer options. 
2. Administrating T1 interface. 
3. Programming AAR for trunk access. 
4. Setting up method of call direction and coverage. 

 
All PBX programming is done via a Windows®-based Java application. The basic commands that you will 
encounter on the PBX to perform these actions are: 
 

change; delete; and add 
 
6.1 Setting Up System Parameters and Customer Options 
 

Use the display system-parameters customer options command such that several Q.SIG and trunk-
specific parameters needed for the integration to operate properly are enabled. 
 
Note that configuration parameters in this area that are not already enabled may require special maintenance or 
configuration by Avaya Customer support and/or may require additional software packages be installed to 
configure properly. Once the command has been entered, press the NEXT PAGE soft key until the Optional 
Features section is displayed as shown below. 
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Review the DCS (Basic), DCS Call Coverage, and DCS with Rerouting options. They must be set to y 
for this integration to work properly. If they are not enabled, then contact your Avaya support representative to 
have these features enabled. 
 
Press the NEXT PAGE soft key, and the next page is displayed. 
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Review the ISDN-PRI option. It must be set to y for this integration to work properly. If this option is not 
enabled, then contact your Avaya support representative to have these features enabled. 
Press the NEXT PAGE soft key, and the next page is displayed. 
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Review the Private Networking and Uniform Dialing Plan options. They must be set to y for this 
integration to work properly. It they are not enabled, then you must contact you Avaya support representative to 
have these features enabled. 
 
Press the NEXT PAGE soft key, until page #8 (QSIG Optional Features) is displayed. 
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Review the Basic Call Setup, Basic Supplementary Services, Centralized Attendant, 
Interworking with DCS, Supplementary Services with Rerouting, Transfer into QSIG 
Voice Mail, and Value Added (VALU) options. They must be set to y for this integration to work properly. 
If they are not enabled, then you need to contact your Avaya support representative to have these features 
enabled. 
 
Use the Change System-Parameter Features command to make some required modifications to the 
systems advanced ISDN and Q.SIG features. In order to make changes to the following fields, you must have 
administrative rights for the Avaya switch. If you do not, then you need to contact your Avaya support 
representative. 
 
Press the NEXT PAGE soft key, until you get to the ISDN PARAMETERS page. 
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• In the QSIG TSC Extension field enter XXXX 
o where XXXX is any unused extension number. 

• In the MWI-Number of Digits Per Voice Mail Subscriber field enter X 
o  where X is the length of digits of the subscribers extensions. 

• In the QSIG Path Replacement Extension field enter XXXX 
o where XXXX is any unused extension number. 

 
Before moving to the next command, be sure to save your work. 
Use the change system-parameters coverage-forwarding command to modify the system features 
relevant for forwarding the extensions and call coverage such that the Q.SIG supplementary services work 
properly. 
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• In the Maintain SBA At Principal field enter y to enable this feature. 
 
Before moving to the step, be sure to save your work. 
 
6.2 Administrating the T1 Interface 
 
Use the add ds1 command to setup the DS1 card with the proper settings. The command takes an argument 
that includes the cabinet and slot number where the DS1 card is located. For example: 
 
Command = add ds1 a11 
 
Add a ds1 circuit card into the configuration that is located in cabinet ‘a’ and is in slot #11 of that cabinet. 
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• In the Name field, enter in any string to assign the DS1 a name 
• In the Bit Rate field, enter 1.544. (The standard clock rate for T1) 
• In the Line Coding field, enter b8zs. 
• In the Line Compression field, enter 1. 
• In the Framing Mode field, enter esf. 
• In the Signaling Mode field, enter isdn-pri. 
• In the Connect field, enter pbx. 
• In the Interface field, enter peer-master. 
• In the Peer Protocol field, enter Q-SIG. 
• In the Interworking Message field, enter PROGress.  
• In the Side field, enter b. 
• In the Interface Companding field, enter mulaw. 
• In the CRC field, enter n. 
• In the Idle Code field, enter 11111111. (8 - 1’s) 

 
Press NEXT PAGE to move to the next page of settings.  
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• In the Far-end CSU Address field, enter b.  
 
Before moving on to the next command, be sure to save your work. 
 
Use the add signaling-group command to build a signaling group for the Q.SIG link to the gateway. This 
signaling group specifies the type of interface being used, the signaling channel (D-channel) wiring address for 
the T1 span being used, and the protocol used on the signaling channel. 
 



Dialogic® 4000 Media Gateway Series Integration Note  

27 

 
 

• In the Group Type field, enter isdn-pri. 
• In the Associated Signaling field, enter y.  
• In the Max number of NCA TSC field, enter 10.  
• In the Primary D-Channel field, enter XXXXX24 

o where XXXXX24 is the 24th port number of the T1 board. 
• In the Max number of CA TSC field, enter 10.  
• In the Trunk Group for Channel Selection field, enter X. 

o where X is the trunk group number created in the next step.  
Note: You will need to return to here and edit this number after you have created the trunk 
group. 

• In the Supplementary Service Protocol field, enter b. 
 
Before moving to the next command, be sure to save your work. 
 
Use the add trunk-group command to add a new trunk group that will contain all the members of the ISDN 
line and tie them together with the signaling group created above. 
 



Avaya S8500 

28 

 
 

• In the Group Type field, enter isdn. 

• In the Group Name field, enter a text string to give the group a name. 
• In the COR field, enter the number of a class of restriction to be used, if there is going to be one.  

Note: Setting any restrictions via a COR can effect how the trunk operates so these should be as liberal 
as possible. 

• In the TN field, enter the proper tenant number. 
• In the TAC field, enter XX 

o where XX is an available DAC (used as a trunk access code) number from the dial-plan. 
• In the Direction field, enter two-way. 

• In the Outgoing Display field, enter y. 

• In the Carrier Medium field, enter PRI/BRI.  

• In the Service Type field, enter tie.  

• In the Supplementary Service Protocol field, enter b.  

• In the Digit Handling (in/out) field, enter enbloc/enbloc.  

• In the Format field, enter unk-unk.  

 
Press NEXT PAGE to advance to the next page of settings. 
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• In the NCA-TSC Trunk Member field, enter 23.  

• In the Send Calling Number field, enter y.  

• In the Format field, enter unk-pvt.  

• In the Outgoing Channel ID Encoding field, enter preferred. 

• In the Send Connected Number field, enter y.  

• In the Send UUI IE field, enter y.  

 
Press NEXT PAGE to advance to the next page of settings. 
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• In the Diversion by Reroute field, enter y.  

• In the Path Replacement field, enter y.  
Note: This parameter enables the path replacement functionality of the Q.SIG supplemental services 
package.  

• In the Path Replacement Method field, you can enter a selection to tune how your path replacement 
optimization is done. 

 
Press NEXT PAGE to advance to the next page of settings. 
 
On this page, enter each bearer channel of the T1 span, leaving off the D-channel since that is connected to 
the group via the Signaling Group and is not used to carry voice. 
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• In each of the Port fields, enter the port number that designates the physical wiring address of each of 
the bearer channels in the span.  

• In each of the corresponding Sig Grp fields, for each port enter in the number of the Signaling Group 
created above. 

 
Before moving on to the next command, be sure to save your work. 
 
6.3 Programming AAR for Trunk Access 
 
Important Note: In order for Path Replacement to work on Join transfers, the inbound calls MUST use an AAR 
number to access the trunk, and NOT the assigned Trunk Access Code (TAC). If an outgoing call is made using 
a TAC, or a call was extended by an attendant using DTGS (Direct Trunk Group Selection), the user has 
intentionally chosen a particular Trunk Group for the outgoing call, and the PBX will not use Path Replacement 
optimization in these cases. 
 
Use the change uniform-dialplan command to setup an extension that can be used to access the trunks 
via AAR. 
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• In the Matching Pattern field, enter a number to define as a dialable AAR number. In this example it 
is 5. 

• In the Len field, enter X 
o where X is the length of your dialable number. In this example 4. 

• In the Del field, enter 0. 

• In the Net field, enter aar. 

• In the Conv field, enter n. 

 
Before moving on to the next command, be sure to save your work. 
 
Use the change route-pattern command to define a route rule pattern that when referenced will direct calls 
to the trunk group you created above. 
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• In the Grp field, enter X. 
o where X is the number of the trunk group assigned above. 

• In the FRL field, enter 0. 

• In the Intw field, enter y. 

• In the CA-TSC Request field, enter as-needed.  

• In the Numbering Format field, enter unk-unk.  

 
Before moving on to the next command, be sure to save your work. 
 
Use the change AAR Digit Analysis Table command to set up AAR to bind your dialable number setup 
in UDP to the route pattern you have just defined. 
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• In the Dialed String field, enter the number you defined in UDP as the AAR number. In this example 

we use 5. 
• In the Min and Max fields, enter the length of the number you are going to dial. In this example 4 for the 

Min and 12 for the Max. 
• In the Route Pattern field, enter the number of the route pattern that you defined above. In this 

example 2. 
• In the Call Type field, enter aar. 

• In the ANI Reqd field, enter n. 

 
Before moving on to the next command, be sure to save your work. 
 
Use the busyout board and the release board commands to reset the trunk device that has been defined. 
When a T1 board is initially programmed, by default it is in a busy state. In order to enable the T1 board, it must 
be set to busy and then released. 
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In both commands, you can use NEXT PAGE to view the trunk channels that are not visible on the page. 
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7. Microsoft® Office Communications Server 2007 (OCS) Setup 
 
 
7.1 Steps for configuring Microsoft® OCS 
 
Normalization rules are used to convert dial numbers into full E.164 formatted numbers. Microsoft® OCS uses 
the standard E.164 format to search for users listed in the Active Directory (AD).  
 
If a Microsoft® OCS user dials an internal extension number (normally 3-5 digits), the normalization rules convert 
it into full E.164 format. These normalization rules should cover dialed digits for internal extensions, local 
numbers, long distance numbers, and international numbers. 
 
To configure Microsoft® OCS, click  
Start > Programs > Administrative Tools > OCS 2007. 
 
On the tree presented in the configuration window, right-click Forest then select Properties and then Voice 
Properties form the menu provided. Edit a location profile as shown in the following example:  
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Click Add or Edit to create or change a particular rule.  
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In this example, when a user dials any 4-digit number, it will be converted to its E.164 equivalent of 
+1716639xxxx and then that number will be searched for in AD. 
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More examples are shown in the following table: 
 

Name Phone Pattern Translation Pattern Comments 

Extensions ^(\d{4})$ +1716639$1 Internal extensions  

Local ^(\d{7})$ +1716$1 Local number 

National ^1(\d*)$ +1$1 Long distance number 

International ^011(\d*) +$1 International number 

 
 
A default route is used to route all calls to Microsoft® Mediation Server. If you need to route some calls to a 
different Microsoft® Mediation Server, configure the Target phone numbers field accordingly. 
 
To configure Microsoft® OCS, click  
Start > Programs > Administrative Tools > OCS 2007. 
 
On the tree presented in the configuration window, right-click Forest then select Properties and then Voice 
Properties form the menu provided. Edit a route as shown in the example below.  
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This entry routes numbers with or without “+” prefix followed by any digits to Microsoft® Mediation Server 
dmg4000.bufocs.local. 
 
Restart the Front End Services for the above changes to take effect, including all normalization rules. This can 
be done from the window Services. 
 
Note: Unless the dialed number from Microsoft® OCS client (such as Microsoft® Office Communicator) is in E.164 
format, Microsoft® OCS must find a normalization rule to convert the dialed number to E.164. If no rule is found 
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or matched, outbound calls will fail. In this case, Dialogic® Diva® Diagnostics trace will not receive an outbound 
SIP message, since the call will not yet have reached the SIP gateway. 
 
 
7.2 Steps for configuring Microsoft® Office Communications Server 2007 (OCS) 

clients  
 
The domain users need to be enabled for making calls through Microsoft® OCS. 
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Under the Communications tab, check the Enable user for Office Communications Server option 
and then click the Configure button. 

 
 
In the above configuration for the hypothetical user Ray Cassick, an inbound PSTN call for 3101 will be 
converted by the Dialogic® Diva® SIPcontrol™ Software to +17166393101 because in the Diva SIPcontrol 
software dialpan in the SIP Peer Configuration section under Address Normalization the: 

• Number format (outbound) is set to International number, and  
• Encoding (outbound) is set to Use type flag.  

 
Microsoft® OCS will ring the user Ray Cassick if he is logged on to Microsoft® OCS from Microsoft® Office 
Communicator or any Microsoft® OCS supported device. 
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8. Microsoft® Mediation Server Installation and Configuration 
 
8.1 Installation 

 
The gateways of the Dialogic® 4000 Media Gateway Series (DMG4000 Gateways) are shipped with pre-installed 
Microsoft® Mediation Server software. You can complete the Microsoft® Mediation Server configuration by 
running Microsoft® Office Communications Server 2007 (OCS) “Setup.exe” in the DMG4000 Gateways. In the 
Microsoft® OCS Deployment Wizard, select Deploy Other Server Roles, then select Deploy Mediation 
Sever. Follow the steps in the Wizard to complete the setup: 
 
Step 1: Install the Microsoft® Mediation Server software. 
 
Step 2: Activate Microsoft® Mediation Server. Use the existing account and enter the password for the service 
account. 
 
Step 3: No action needed. Do this step when the installation is complete. 
 
Step 4: Configure Certificate.  

1. Download the CA certification path for Microsoft® Mediation Server.  
• From Start > Run, enter http://<CA server>/certsrv. 
• Select to download a CA certificate, chain or CRL. 
• Click Download CA certificate chain. 
• In File Download, click Save. 

2. Install the certificate chain for the Microsoft® Mediation Server: 
• In the Deployment Wizard, run step 4 again. 
• Select Import a certificate chain from a .p7b file in step 1.  

3. Verify that your CA is in the list of Trusted root CAs: 
• In the Microsoft® Management Console (MMC) snap-in, click Certificates (If not already 

done, add it.) 
• Verify that CA is on the list of trusted CAs as shown in the example below. 
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4. Create the certificate request for the Microsoft® Mediation Server: 
• Run Deployment Wizard, click step 4. 
• Select the option Create a new certificate. 
• Select the option Send the request immediately to an online CA. 
• Complete the settings in the blank. 
• Click Assign to complete the task. 

 
Note: If you receive the error message “certificate expired or is not yet valid” when you click the assign button at 
the end of step 4, check the time/time zone configured for your Microsoft®  Mediation Server is correct, then run 
the Deployment Wizard again or click Certificates in Available tasks in Microsoft® Mediation Server 
MMC snap-in. 
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8.2 Configuration 
 
From the MMC snap-in, right-click the detected Microsoft® Mediation Server and select Properties. 
 

 
 



Dialogic® 4000 Media Gateway Series Integration Note  

47 

Configure the following settings on the General tab:  
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Click the Next Hop Connections tab and configure the following:  
 

 
 
The Port entry under PSTN Gateway Next hop has to match the configuration in the Dialogic® Diva® 
SIPcontrol™ Software under Network Interface Configuration > SIP Listen Port.  
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Click the Certificate tab.  
 

 
 
Select the certificate that will be used to communicate with Microsoft® OCS. Microsoft® Mediation Server will 
need to restart for these changes to properly take effect. 
 
9. Testing the Validation Matrix 
 
The table below shows various test scenarios that are run as typical validation scenarios if the Dialogic® Media 
Gateway is used in a voice messaging situation. The notes column specifies any notable parts of the test. 
 
The test scenarios below assume that all gateway configuration parameters are at their default values. For a 
sample showing call flows and states please consult the Gateway SIP Compatibility Guide. 
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Test 
Number 

Call Scenario Description Notes 

Inbound call scenarios 

1 Direct call from TDM station set to 
Microsoft® OCS client. 

 

2 Direct call from Microsoft® OCS client to 
TDM station set. 

 

 
 
10. Troubleshooting 
 
10.1 Important Debugging Tools 
 

• Ethereal/Wireshark: Can be used to view and analyze the network captures provided by the Dialogic 
gateway diagnostic firmware. 

• Adobe Audition: Can be used to review and analyze the audio extracted from the network captures to 
troubleshoot any audio related issues. 

• Dialogic® Diva® Diagnostics tool: Used to review and analyze all SIP and ISDN traffic that relates to 
calls going into and leaving the Dialogic® 4000 Media Gateway. 

 
10.2 Using the Dialogic® Diva® Diagnostics Tool 

 
Before using the Dialogic® Diva® Diagnostics tool, you would need to enable it by setting the Dialogic® Diva® 
SIPcontrol™ Software debug. To do so, open the Diva SIPcontrol software web interface, click the link System 
Settings, and set Debug Level to Extended. Click the Save button for the changes to take effect. 
 
Now, you can start the Diva Diagnostics tool. To do so, click:  
Start > Programs > Dialogic Diva > Diagnostics. 
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1. Click one line of your Dialogic® Diva® Media Board in the left pane and click  on the toolbar to activate 
the Basic tracing level. This level captures Q.931 ISDN messages.  
 

2. Click CAPI driver in the left pane and activate the Basic tracing level as explained in step 1. 
 

3. Start tracing. To do so, click the start icon  or select the Start Tracing option form the Tracing 
menu. 
 

4. Reproduce the issue. 
 

5. To stop tracing, click the stop icon  on the tool bar or select the Stop Tracing option form the 
Tracing menu. 

 

6. To view your collected trace, click the view icon  on the toolbar or select the View Recorded 
Trace option from the View menu. A notepad window will open with the recorded log. 
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Examples of Dialogic® Diva® Diagnostics traces for an inbound (TDM to IP) call to Microsoft® Office 
Communications Server 2007 (OCS) 
 
Basic notations for reading the trace: 
 

• SIG-R: RX Q.931 ISDN message 
• SIG-X: TX Q.931 ISDN message 
• SIPR: RX SIP message 
• SIPX: TX SIP message 

 
< Below is a RX Q.931 ISDN message for an inbound call > 
… 
9:16:28.431 C  3 21:2389:383 - SIG-R(030) 08 02 00 17 05 04 03 80 90 A2 18 03 A9 83 81 6C 06 01 A0 33 
30 30 32 70 05 C1 35 31 30 31 
                     Q.931  CR0017 SETUP 
                            Bearer Capability 80 90 a2 
                            Channel Id a9 83 81 
                            Calling Party Number 01 a0 '2401' 
                            Called Party Number c1 '5101' 
 
… 

<Below is a TX SIP message with SDP> 
 
9:16:28.431 1 L 12 00010000-SIPX begin to IP:192.168.0.106 port:5060 socket:3 Proto:TCP 
 9:16:28.431 1 L 12 00010000-    >INVITE sip:+17166395101@dmg4000.bufocs.local:5060 SIP/2.0 
 9:16:28.431 1 L 12 00010000-    >Via: SIP/2.0/TCP 192.168.0.106:9803;branch=z9hG4bK2617534104-7603272 
 9:16:28.431 1 L 12 00010000-    >Max-Forwards: 70 
 9:16:28.431 1 L 12 00010000-    >Allow: INVITE,ACK,CANCEL,BYE,OPTIONS,NOTIFY,REFER 
 9:16:28.431 1 L 12 00010000-    >Accept: application/sdp,application/simple-message-summary 
 9:16:28.431 1 L 12 00010000-    >Supported: timer,replaces 
 9:16:28.431 1 L 12 00010000-    >From: "Dialogic Diva SIPcontrol" 
<sip:+17166392401@192.168.0.106;user=phone>;tag=sipcontrol_2617534104-7668808 
 9:16:28.431 1 L 12 00010000-    >To: "Default" <sip:+17166395101@bufocs.local;user=phone> 
 9:16:28.431 1 L 12 00010000-    >Call-ID: 9c046698-730448-17@dmg4000 
 9:16:28.431 1 L 12 00010000-    >CSeq: 1 INVITE 
 9:16:28.431 1 L 12 00010000-    >Min-SE: 90 
 9:16:28.431 1 L 12 00010000-    >Session-Expires: 600;refresher=uac 
 9:16:28.431 1 L 12 00010000-    >Contact: <sip:+17166392401@192.168.0.106:9803> 
 9:16:28.431 1 L 12 00010000-    >Content-Type: application/sdp 
 9:16:28.431 1 L 12 00010000-    >Content-Length: 253 
 9:16:28.431 1 L 12 00010000-    > 
 9:16:28.431 1 L 12 00010000-    >v=0 
 9:16:28.431 1 L 12 00010000-    >o=SIPcontrol 7472200 7472200 IN IP4 192.168.0.106 
 9:16:28.431 1 L 12 00010000-    >s=- 
 9:16:28.431 1 L 12 00010000-    >c=IN IP4 192.168.0.106 
 9:16:28.431 1 L 12 00010000-    >t=0 0 
 9:16:28.431 1 L 12 00010000-    >m=audio 30060 RTP/AVP 8 0 101 13 
 9:16:28.431 1 L 12 00010000-    >a=rtpmap:8 PCMA/8000 
 9:16:28.431 1 L 12 00010000-    >a=rtpmap:0 PCMU/8000 
 9:16:28.431 1 L 12 00010000-    >a=rtpmap:101 telephone-event/8000 
 9:16:28.431 1 L 12 00010000-    >a=fmtp:101 0-15 
 9:16:28.431 1 L 12 00010000-    >a=rtpmap:13 CN/8000 
 9:16:28.431 1 L 12 00010000-    >a=sendrecv 
 9:16:28.431 1 L 12 00010000-SIPX end 
… 
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<Below is a RX SIP message> 
 
9:16:28.431 1 L 12 00010000-SIPR begin (331 byte) from IP:192.168.0.106 PORT:5060 on socket 3 port 5060 
TCP 
 9:16:28.431 1 L 12 00010000-    >SIP/2.0 100 Trying 
 9:16:28.431 1 L 12 00010000-    >FROM: "Dialogic Diva 
SIPcontrol"<sip:+17166392401@192.168.0.106;user=phone>;tag=sipcontrol_2617534104-7668808 
 9:16:28.431 1 L 12 00010000-    >TO: "Default"<sip:+17166395101@bufocs.local;user=phone> 
 9:16:28.431 1 L 12 00010000-    >CSEQ: 1 INVITE 
 9:16:28.431 1 L 12 00010000-    >CALL-ID: 9c046698-730448-17@dmg4000 
 9:16:28.431 1 L 12 00010000-    >VIA: SIP/2.0/TCP 192.168.0.106:9803;branch=z9hG4bK2617534104-7603272 
 9:16:28.431 1 L 12 00010000-    >CONTENT-LENGTH: 0 
 9:16:28.431 1 L 12 00010000-    > 
 9:16:28.431 1 L 12 00010000-SIPR end 
… 
9:16:28.665 0 L 12 00010000-SIPR begin (408 byte) from IP:192.168.0.106 PORT:5060 on socket 3 port 5060 
TCP 
 9:16:28.665 0 L 12 00010000-    >SIP/2.0 183 Session Progress 
 9:16:28.665 0 L 12 00010000-    >FROM: "Dialogic Diva 
SIPcontrol"<sip:+17166392401@192.168.0.106;user=phone>;tag=sipcontrol_2617534104-7668808 
 9:16:28.665 0 L 12 00010000-    >TO: 
Default<sip:+17166395101@bufocs.local;user=phone>;epid=CE4C602FA5;tag=3f5ea65423 
 9:16:28.665 0 L 12 00010000-    >CSEQ: 1 INVITE 
 9:16:28.665 0 L 12 00010000-    >CALL-ID: 9c046698-730448-17@dmg4000 
 9:16:28.665 0 L 12 00010000-    >VIA: SIP/2.0/TCP 192.168.0.106:9803;branch=z9hG4bK2617534104-7603272 
 9:16:28.665 0 L 12 00010000-    >CONTENT-LENGTH: 0 
 9:16:28.665 0 L 12 00010000-    >SERVER: RTCC/3.0.0.0 MediationServer 
 9:16:28.665 0 L 12 00010000-    > 
 9:16:28.665 0 L 12 00010000-SIPR end 
… 
9:16:28.869 1 L 12 00010000-SIPR begin (399 byte) from IP:192.168.0.106 PORT:5060 on socket 3 port 5060 
TCP 
 9:16:28.869 1 L 12 00010000-    >SIP/2.0 180 Ringing 
 9:16:28.869 1 L 12 00010000-    >FROM: "Dialogic Diva 
SIPcontrol"<sip:+17166392401@192.168.0.106;user=phone>;tag=sipcontrol_2617534104-7668808 
 9:16:28.869 1 L 12 00010000-    >TO: 
Default<sip:+17166395101@bufocs.local;user=phone>;epid=CE4C602FA5;tag=3f5ea65423 
 9:16:28.869 1 L 12 00010000-    >CSEQ: 1 INVITE 
 9:16:28.869 1 L 12 00010000-    >CALL-ID: 9c046698-730448-17@dmg4000 
 9:16:28.869 1 L 12 00010000-    >VIA: SIP/2.0/TCP 192.168.0.106:9803;branch=z9hG4bK2617534104-7603272 
 9:16:28.869 1 L 12 00010000-    >CONTENT-LENGTH: 0 
 9:16:28.869 1 L 12 00010000-    >SERVER: RTCC/3.0.0.0 MediationServer 
 9:16:28.869 1 L 12 00010000-    > 
 9:16:28.869 1 L 12 00010000-SIPR end 
… 
9:16:30.197 1 L 12 00010000-SIPR begin (836 byte) from IP:192.168.0.106 PORT:5060 on socket 3 port 5060 
TCP 
 9:16:30.197 1 L 12 00010000-    >SIP/2.0 200 OK 
 9:16:30.197 1 L 12 00010000-    >FROM: "Dialogic Diva 
SIPcontrol"<sip:+17166392401@192.168.0.106;user=phone>;tag=sipcontrol_2617534104-7668808 
 9:16:30.197 1 L 12 00010000-    >TO: 
Default<sip:+17166395101@bufocs.local;user=phone>;epid=CE4C602FA5;tag=3f5ea65423 
 9:16:30.197 1 L 12 00010000-    >CSEQ: 1 INVITE 
 9:16:30.197 1 L 12 00010000-    >CALL-ID: 9c046698-730448-17@dmg4000 
 9:16:30.197 1 L 12 00010000-    >VIA: SIP/2.0/TCP 192.168.0.106:9803;branch=z9hG4bK2617534104-7603272 
 9:16:30.197 1 L 12 00010000-    >CONTACT: 
<sip:dmg4000.BufOCS.local:5060;transport=Tcp;maddr=192.168.0.106> 
 9:16:30.197 1 L 12 00010000-    >CONTENT-LENGTH: 253 
 9:16:30.197 1 L 12 00010000-    >SUPPORTED: 100rel 
 9:16:30.197 1 L 12 00010000-    >CONTENT-TYPE: application/sdp; charset=utf-8 
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 9:16:30.197 1 L 12 00010000-    >ALLOW: UPDATE 
 9:16:30.197 1 L 12 00010000-    >SERVER: RTCC/3.0.0.0 MediationServer 
 9:16:30.197 1 L 12 00010000-    >ALLOW: Ack, Cancel, Bye,Invite 
 9:16:30.197 1 L 12 00010000-    > 
 9:16:30.197 1 L 12 00010000-    >v=0 
 9:16:30.197 1 L 12 00010000-    >o=- 0 0 IN IP4 192.168.0.106 
 9:16:30.197 1 L 12 00010000-    >s=session 
 9:16:30.197 1 L 12 00010000-    >c=IN IP4 192.168.0.106 
 9:16:30.197 1 L 12 00010000-    >b=CT:1000 
 9:16:30.197 1 L 12 00010000-    >t=0 0 
 9:16:30.197 1 L 12 00010000-    >m=audio 62438 RTP/AVP 8 101 
 9:16:30.197 1 L 12 00010000-    >c=IN IP4 192.168.0.106 
 9:16:30.197 1 L 12 00010000-    >a=rtcp:62439 
 9:16:30.197 1 L 12 00010000-    >a=label:Audio 
 9:16:30.197 1 L 12 00010000-    >a=rtpmap:8 PCMA/8000 
 9:16:30.197 1 L 12 00010000-    >a=rtpmap:101 telephone-event/8000 
 9:16:30.197 1 L 12 00010000-    >a=fmtp:101 0-16 
 9:16:30.197 1 L 12 00010000-    >a=ptime:20 
 9:16:30.197 1 L 12 00010000-SIPR end 
… 

<Bellow is a TX Q.931 ISDN message, after SIP session is established> 
 
9:16:30.212 C  3 21:2391:136 - SIG-X(005) 08 02 80 17 07 
                     Q.931  CR8017 CONN 



Dialogic® 4000 Media Gateway Series Integration Note  

55 

 
 
 
 
 


